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Introductory Introductory -- PIC 101PIC 101

Introduction to PICIntroduction to PIC®® MCUs MCUs 
HandsHands--on Workshopon Workshop
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In this workshop you will In this workshop you will 
have a chance to:have a chance to:

Explore different application areas where microcontrollers 
are used 
Develop a real world working application
Work with Microchip’s development tools
– PICSTART Plus programmer
– MPLAB software/application development manager
– Workshop board
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What you will do...What you will do...continuedcontinued

Develop application code
Test your design
– Workshop board
– Scale model prototype

Develop higher order functions
Evaluate your design on a workshop board 
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Agenda Day 1Agenda Day 1

Review of architecture and instruction set
Break
Basic tools usage
Lunch
Switching
Timing
Break
Timing (continued)

Motor/motion control
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Agenda Day 2Agenda Day 2

Motor/motion control (continued)

Sensing inputs
Break
Sensing inputs (continued)

State logic and higher order functions
Lunch
State logic and higher order functions (continued)

Break
Proof on scale model prototype
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Why Microchip?Why Microchip?

High reliability
Feature creep solution
Speed of implementation
Development tools suite
Lower cost
Field upgrades
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Final project goalFinal project goal

Automatic door controller (commercial type)
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What feature set?What feature set?



5

© 1999 Microchip Technology Incorporated. All Rights Reserved.

What feature setWhat feature set

– Open/close
– Switch controlled
– Held open to allow passage through door
– Automatic close (store type) 
– Safety cutoffs (if time permits)
– Independent motor cutoff (if time permits)
– Double tap (if time permits)
– Lighting control (optional)
– Sound control (optional)
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Microcontroller applications involved Microcontroller applications involved 

Switching
Timing
Movement/motor control
Sensing
State decisions/logic
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PIC 101PIC 101

ArchitectureArchitecture
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PIC ArchitecturePIC Architecture
RISCRISC--like Featureslike Features

Harvard architecture

Register file concept

All instructions single-word

LWI (Long Word Instruction)

Instruction pipelining

Single-cycle instructions

Reduced instruction set

Orthogonal instruction set

The high performance of the PIC MCU family can 
be attributed to the following architectural 
features:
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PIC ArchitecturePIC Architecture
Harvard ArchitectureHarvard Architecture

Fetches instructions and data from one 
memory.
– Limits Operating Bandwidth

Two separate memory spaces for 
instructions 
and data.
– Increases throughput
– Different program and data bus 

widths are possible

ProgramProgram
and Dataand Data
MemoryMemory

Von NeumannVon Neumann

88--BitsBits

CPUCPU

ProgramProgram
MemoryMemory

DataData
MemoryMemory

88--BitsBits

12/14/1612/14/16--BitsBits

HarvardHarvard

CPUCPU
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Flush FetchFlush Fetch 44
Fetch SUB_1Fetch SUB_1

In most microcontrollers, instructions are fetched and executed 
sequentially.
Allows overlap of fetch and execution.
Makes single cycle execution.
Program branches (e.g. GOTO, CALL or Write to PC) takes two cycles.

Tcy0    Tcy1    Tcy2    Tcy3    Tcy4

PIC MCU ArchitecturePIC MCU Architecture
PipeliningPipelining

Execute 1Execute 1

Fetch 3Fetch 3

1. MOVLW 55h1. MOVLW 55h Fetch 1Fetch 1

Execute 3Execute 3
Fetch 2Fetch 2 Execute 2Execute 2

Fetch 4Fetch 4

2. MOVWF  PORTB2. MOVWF  PORTB
3. CALL SUB_13. CALL SUB_1
4. BSF PORTA, BIT34. BSF PORTA, BIT3
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Program
Bus

EPROM
Program
Memory

Clock/Counter

T0CKI

I/O Ports

Ports

Peripheral(s)
Instruction
Decode &
Control

Timing
Generation

MCLR

OSC1
OSC2

Watchdog
Timer

Power-on
Reset

OSC Start
-upTimer

Brown-out
Reset

PIC MCU ArchitecturePIC MCU Architecture
Block DiagramBlock Diagram

Program Counter

STACK1

STACKn

STATUS Reg

Mux

W Reg

ALU

MOVF PORTB,W

00100000000110

001000    0 0000110

001000    0

0000110

01010101

01010101

Direct Addr

Addr Mux

RAM
File Registers

Data Bus

Instruction Reg Indirect Data 
Address
FSR

MOVLW 0xAA

11000010101010

MOVF INDF,W

00100000000000

10101010

110000      10101010001000    0 0000000 000000

110000001000    0
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PIC ArchitecturePIC Architecture
Register File ConceptRegister File Concept

General PurposeGeneral Purpose
Registers (RAM)Registers (RAM)

Other SFRsOther SFRs
PORTAPORTA

FSRFSR
STATUSSTATUS

PCLPCL
TMR0TMR0
INDFINDF

W RegisterW Register

ALUALU

DataData
MemoryMemory

Direct data addr <7>Direct data addr <7>Op code <7>Op code <7>

1414--bit Instruction Format Example:bit Instruction Format Example:

RAM is a bank of general RAM is a bank of general 
purpose registers.purpose registers.
Peripherals (I/O) are Peripherals (I/O) are 
registers.registers.
All instructions operate on All instructions operate on 
any register.any register.
Long word instruction Long word instruction 
allows direct addressing of  allows direct addressing of  
registers.registers.
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Quiz 1Quiz 1

1) All of Microchip’s PIC instructions 
are _____.

2) The PIC pipeline must be flushed 
whenever ____  is modified. 

Single Cycle
Single Byte
Single Word

W register
PortB
PC
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PIC ArchitecturePIC Architecture

MemoryMemory
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PIC ArchitecturePIC Architecture
MemoryMemory

2 types of memory
– Program
– Data

Organization
– Pages (program)
– Banks (data)
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PIC ArchitecturePIC Architecture
Paging / Banking Boundary SummaryPaging / Banking Boundary Summary

PIC16/17
Family

Word
Size
(Bits)

Code
Page

Boundary
(Words)

Current
Max code

Size
(Words)

Register
Bank

Boundary
(Bytes)

Current
Max RAM

Size
(Bytes)

16F5X 12 512 2K 32 73

16FXXX 14 2048 8K 128 368

17CXXX 16 8192 16K/64K 256 902



11

© 1999 Microchip Technology Incorporated. All Rights Reserved.

PIC16FXX ArchitecturePIC16FXX Architecture
Program MemoryProgram Memory

Maximum 8K Bytes 
(13 bits) of program memory 
space
Four Pages each 2K bytes (11 
bits)
Page access using  
PCLATH<4:3>
Reset Vector at 0000h
Interrupt Vector at 0004h

Page 0Page 0

0000h0000h

0004h0004h

07FFh07FFh

InterruptInterrupt

ResetReset

Page 1Page 1

0800h0800h

0FFFh0FFFh

Page 2Page 2

1000h1000h

17FFh17FFh

Page 3Page 3

1800h1800h

1FFFh1FFFh

PCLATH<4:3> = 00PCLATH<4:3> = 00

PCLATH<4:3> = 01PCLATH<4:3> = 01

PCLATH<4:3> = 10PCLATH<4:3> = 10

PCLATH<4:3> = 11PCLATH<4:3> = 11

© 1999 Microchip Technology Incorporated. All Rights Reserved.

PIC ArchitecturePIC Architecture
Paging program memoryPaging program memory

Paging needs consideration ONLY when executing program CALL or 
GOTO operation
Modify page bits ONLY when jumping to different page than last jumped
– page bits define desired page execution

Instructions invoking page bits:
– GOTO <address>
– CALL <address>
– <Instruction> PCL,F ; e.g.  ADDWF   PCL,F

There are no paging considerations when returning
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PIC ArchitecturePIC Architecture
Paging program memoryPaging program memory

ADDWF PCL,F has eight bits (256 words) of address
– In PIC16F5X PA0, PA1 determine final page

– Bit 8 of PC is cleared by hardware
– Destination address must be first 256 of page

– In PIC16FXXX/17CXXX, PCLATH is used for upper  address  
– Destination address can be anywhere
– Look-up tables that cross a 256 word boundary require pre-

conditioning of PCLATH
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PC
12 8 7 0

5
PCLATH<4:0>

PCLATH

INST with PCL
as dest

ALU result

GOTO, CALL

Opcode <10:0>

8

PC

12 11 10 0

11PCLATH<4:3>

PCH PCL

8 7

2

PCLATH

PCH PCL

PIC16F84APIC16F84A

PIC ArchitecturePIC Architecture
Paging program memoryPaging program memory

PA1:PA02

STATUS

PC
8 7 0

PCL
910

PA1:PA02

STATUS

PC
8 7 0

PCL
910

Instruction Word 

Reset to ‘0’

Instruction Word 

7 0

7 0

GOTO Instruction

CALL or Modify PCL Instruction

PIC16F57PIC16F57
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PC<12:0>

Stack Level 1
•
•
•

Stack Level 8

Reset Vector

Peripheral Interrupt Vector

U
se

r M
em

or
y

Sp
ac

e

CALL, RETURN
RETFIE, RETLW

13

0000h

0004h

1FFFh

3FFh

PIC16F57

Program Memory MapProgram Memory Map
PIC16F84A

PC<10:0>

Stack Level 1
Stack Level 2 

U
se

r M
em

or
y

Sp
ac

e

11

000h

1FFh

Reset Vector

0FFh
100h

On-chip Program
Memory (Page 0)

On-chip Program
Memory (Page 1)

On-chip Program
Memory (Page 2)

On-chip Program
Memory (Page 3)

200h

3FFh

2FFh
300h

400h

5FFh

4FFh
500h

600h

7FFh

6FFh
700h

CALL, RETLW
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PIC Architecture
Program Memory: Immediate Operation

8-bit constant (literal) value included in     
instruction word.

Used by literal instructions such as    
movlw, addlw, retlw, etc.

OP CODEOP CODE kk

1414--bit Instruction for Literal Instructionsbit Instruction for Literal Instructions

kk kk kk kk kk kk kk
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PIC Architecture
Program Memory: PC Absolute Addressing

OP CODEOP CODE kk kk kk kk

1414--bit Instruction for call and gotobit Instruction for call and goto

kk kk kk kk kk kk kk

Used by control instructions CALL and GOTO   
to modify the PC (Program Counter)

kk kk kk kk kk kk kk kk kk

xx xx xx kk kk xx xx xx

PCLATH RegisterPCLATH Register

Effective 13Effective 13--bit Program Memory Addressbit Program Memory Address

1111--bits From Instructionbits From Instruction
22--bits bits 
FromFrom
PCLATHPCLATH

kk kk kk kk

© 1999 Microchip Technology Incorporated. All Rights Reserved.

PIC Architecture
PCPC Relative Addressing (14-bit core)

PCH <5>PCH <5> PCL <8>PCL <8>

1313--Bit Program CounterBit Program Counter

PCLATH <5>PCLATH <5>

Internal Data Bus <8>Internal Data Bus <8>

55

55

88

First write high byte to PCLATH.First write high byte to PCLATH.
Next write low byte to PCL, this loads the entireNext write low byte to PCL, this loads the entire
1313--bit value to PC.bit value to PC.

movlwmovlw HIGH DelayHIGH Delay
movwfmovwf PCLATHPCLATH
movlwmovlw LOW DelayLOW Delay
movwfmovwf PCLPCL

Note: PCH cannot be readNote: PCH cannot be read
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0000000000000000XXXXXXXXXXXXXXXX

PIC MCU Architecture
PC Relative Addressing

Look-up Table Example
movlwmovlw HIGH DecodeHIGH Decode
movwfmovwf PCLATHPCLATH
movfmovf DisplayValue,WDisplayValue,W
callcall DecodeDecode
movwfmovwf PORTBPORTB
gotogoto ContinueContinue

DecodeDecode
addwfaddwf PCL,FPCL,F
retlwretlw BB’’0011111100111111’’ ;decode 0;decode 0
retlwretlw BB’’0000011000000110’’ ;decode 1;decode 1
retlwretlw BB’’0101101101011011’’ ;decode 2;decode 2
retlwretlw BB’’0100111101001111’’ ;decode 3;decode 3
retlwretlw BB’’0110011001100110’’ ;decode 4;decode 4
retlwretlw BB’’0110110101101101’’ ;decode 5;decode 5
retlwretlw BB’’0111110101111101’’ ;decode 6;decode 6
retlwretlw BB’’0000011100000111’’ ;decode 7;decode 7
retlwretlw BB’’0111111101111111’’ ;decode 8;decode 8
retlwretlw BB’’0110111101101111’’ ;decode 9;decode 9

ContinueContinue

bb

ee

gg

aa

ff

dd

cc

RB0
RB1
RB2

RB3
RB4
RB5

RB6

b
c

d
e
f
g

W RegisterW Register I/O Port BI/O Port B
011011010110110100000101 00000101 

movfmovf DisplayValue,WDisplayValue,W
callcall DecodeDecode

addwfaddwf PCL,FPCL,F

retlwretlw BB’’0110110101101101’’ ;decode 5;decode 5

movwfmovwf PORTBPORTB

01101101 01101101 

gg

aa

ff

dd

cc

bb

ee
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PIC16FXX ArchitecturePIC16FXX Architecture
Data MemoryData Memory

Four banks each of 128 
bytes of Data Memory
Special Function Registers 
(SFRs) are mapped in top 
32 locations
Banks selected by RP0,1 
and IRP in Status register

GPRsGPRs

SFRsSFRs

Bank0Bank0

000h000h

01Fh01Fh
020h020h

07Fh07Fh

GPRsGPRs

SFRsSFRs

Bank1Bank1

080h080h

09Fh09Fh
0A0h0A0h

0FFh0FFh
0F0h0F0h

GPRsGPRs

SFRsSFRs

Bank2Bank2

100h100h

11Fh11Fh
120h120h

17Fh17Fh
170h170h

GPRsGPRs

SFRsSFRs

Bank3Bank3

180h180h

19Fh19Fh
1A0h1A0h

1FFh1FFh
1F0h1F0h

RP<1:0>               RP<1:0>               RP<1:0>             RP<1:0>               RP<1:0>               RP<1:0>             RP<1:0>RP<1:0>
= 00                      = 01                      = 10     = 00                      = 01                      = 10     = 11= 11
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PIC ArchitecturePIC Architecture
Methods for accessing data memoryMethods for accessing data memory

Direct
Indirect 

© 1999 Microchip Technology Incorporated. All Rights Reserved.

PIC ArchitecturePIC Architecture
Data Memory: Direct AddressingData Memory: Direct Addressing

7-bit direct address from the instruction
2-bits from STATUS register

Effective 9Effective 9--bit Register Addressbit Register Address

IRPIRP RP1RP1RP0RP0 OP CODEOP CODETOTO PDPD ZZ DCDC CC

STATUS RegisterSTATUS Register 1414--bit Instructionbit Instruction
ff ff ff ff ff ff ff

RP1RP1 RP0RP0 ff ff ff ff ff ff ff

77--bits From Instruction Wordbits From Instruction Word

22--bits Frombits From
STATUS STATUS 
RegisterRegister
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IRPIRP ff ff ff ff ff ff ff ff

ff

PIC ArchitecturePIC Architecture
Data Memory: Indirect AddressingData Memory: Indirect Addressing

8-bit indirect address from the FSR (File Select Register).
1-bit from STATUS register.

IRPIRP RP1RP1 RP0RP0 TOTO PDPD ZZ DCDC CC ff ff ff ff ff ff ff

STATUS RegisterSTATUS Register 88--bit FSR Registerbit FSR Register

Effective 9Effective 9--bit Register Addressbit Register Address

88--bits From FSRbits From FSR

11--bit Frombit From
STATUS STATUS 
RegisterRegister

© 1999 Microchip Technology Incorporated. All Rights Reserved.

PIC ArchitecturePIC Architecture
Data Memory: Indirect AddressingData Memory: Indirect Addressing

Clear all RAM locations from 0x20 to 0x7F.
Indirect address is loaded into FSR.
Every time INDF is used as operand, register 
pointed to by FSR is actually used.

movlwmovlw 0x200x20
movwfmovwf FSRFSR

LOOPLOOP clrfclrf INDFINDF
incfincf FSR,FFSR,F
btfssbtfss FSR,7FSR,7
gotogoto LOOPLOOP
<next instruction><next instruction>

0000 00000000 0000

0000 00000000 0000

FSR = 20hFSR = 20h

INDFINDF00h00h

04h04h

20h20h

7Fh7Fh

Data MemoryData Memory
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File Address

00 h

01 h

02 h

03 h

04 h

05 h

06 h

07 h
08 h

09 h

0Ah

0Bh

0Ch

7Fh

80 h

81 h

82 h

83 h

84 h

85h

86 h

87 h
88 h

89 h

8A h

8B h

8 Ch

FF h
Bank 0 Bank 1

Indirect addr. (1) Indirect addr. (1)

TMR0 OPTION _REG

PCL

STATUS

FSR

PORTA

PORTB

EEDATA

EEADR

PCLATH

INTCON

68 
General
Purpose
Registers
SRAM)

PCL

STATUS

FSR

TRISA

TRISB

EECON1

EECON2 (1)

PCLATH

INTCON

Mapped

in Bank 0

Unimplemented data memory location; read as '0'.

File Address

Not a physical register.

CFh
D0h

4Fh
50h

(accesses)

Register File MapRegister File Map
PIC16F84APIC16F84A

PIC ArchitecturePIC Architecture
Data memory mapData memory map
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Quiz 2Quiz 2

1) What bits must you set prior to 
calling a subroutine?

2) What bits must you set prior to 
returning from a subroutine?

3) Data tables in program memory do 
not need to have page bits set.

Both
Page
Bank
Neither

Both
Page
Bank
Neither

True
False
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Quiz2 (cont.)Quiz2 (cont.)

4) For the 12-bit core, what SFR 
register and respective bits are 
needed to access different  
pages in program memory ?

5) For the 14-bit core, what SFR 
register and respective bits are 
needed to access different 
pages in program memory?

6) What bits are needed to access 
different RAM banks?

_________________________
_________________________
_________________________

_________________________
_________________________
_________________________

1)________________________
2)________________________
3)________________________
4)________________________

© 1999 Microchip Technology Incorporated. All Rights Reserved.

PIC MCUsPIC MCUs

Instruction SetInstruction Set
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PIC MCU Instruction SetPIC MCU Instruction Set

33 instructions 12-bit core
35 instructions 14-bit core
58 instructions 16-bit core
– Easy to learn
– High compaction
– Very powerful single-word instructions
– All single-cycle except program branches
– Upward compatibility of instructions

© 1999 Microchip Technology Incorporated. All Rights Reserved.

PIC Instruction Set
14-bit core Summary

NOPNOP -- No OperationNo Operation
MOVWFMOVWF ff Move W to fMove W to f
CLRWCLRW -- Clear WClear W
CLRFCLRF ff Clear fClear f
SUBWFSUBWF f,df,d Subtract W from fSubtract W from f
DECFDECF f,df,d Decrement fDecrement f
IORWFIORWF f,df,d Inclusive OR W and fInclusive OR W and f
ANDWFANDWF f,df,d AND W and fAND W and f
XORWFXORWF f,df,d Exclusive OR W and fExclusive OR W and f
ADDWFADDWF f,df,d Add W and fAdd W and f
MOVFMOVF f,df,d Move fMove f
COMFCOMF f,df,d Complement fComplement f
INCFINCF f,df,d Increment fIncrement f
DECFSZDECFSZ f,df,d Decrement f, skip if zeroDecrement f, skip if zero
RRFRRF f,df,d Rotate right f through carryRotate right f through carry
RLFRLF f,df,d Rotate left f through carryRotate left f through carry
SWAPFSWAPF f,df,d Swap nibbles of fSwap nibbles of f
INCFSZINCFSZ f,df,d Increment f, skip if zeroIncrement f, skip if zero

BCFBCF f,bf,b Bit clear fBit clear f
BSFBSF f,bf,b Bit set fBit set f
BTFSCBTFSC f,bf,b Bit test f, skip if clearBit test f, skip if clear
BTFSSBTFSS f,bf,b Bit test f, skip if setBit test f, skip if set

SLEEPSLEEP -- Go into standby modeGo into standby mode
CLRWDTCLRWDT -- Clear watchdog timerClear watchdog timer
RETLWRETLW kk Return, place literal in WReturn, place literal in W
RETFIERETFIE -- Return from interruptReturn from interrupt
RETURNRETURN -- Return from subroutineReturn from subroutine
CALLCALL kk Call subroutineCall subroutine
GOTOGOTO kk Go to address (k is 9Go to address (k is 9--bit)bit)
MOVLWMOVLW kk Move literal to WMove literal to W
IORLWIORLW kk Inclusive OR literal with WInclusive OR literal with W
ADDLWADDLW kk Add literal with WAdd literal with W
SUBLWSUBLW kk Subtract W from literalSubtract W from literal
ANDLWANDLW kk AND literal with WAND literal with W
XORLWXORLW kk Exclusive OR literal with WExclusive OR literal with W

ByteByte--Oriented OperationsOriented Operations BitBit--Oriented OperationsOriented Operations

Literal and Control OperationsLiteral and Control Operations

f = File Register, k = literal value (8-bit), b = bit address <0,7>, d = destination (0=W, 1=f)
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PIC Instruction Set
Byte-Oriented Operations

1414--bit Instruction for Byte Oriented Operationsbit Instruction for Byte Oriented Operations

OP CODEOP CODE dd ff ff ff ff ff ff ff

d = Destination Bitd = Destination Bit
d = 0 for destination Wd = 0 for destination W
d = 1 for destination fd = 1 for destination f

f = 7f = 7--bit Register Addressbit Register Address

Example:Example:
ADDWF   ADDWF   REG, WREG, W
ADDWFADDWF f, df, d

NOPNOP --
MOVWFMOVWF ff
CLRWCLRW --
CLRFCLRF ff
SUBWFSUBWF f,df,d
DECFDECF f,df,d
IORWFIORWF f,df,d
ANDWFANDWF f,df,d
XORWFXORWF f,df,d
ADDWFADDWF f,df,d
MOVFMOVF f,df,d
COMFCOMF f,df,d
INCFINCF f,df,d
DECFSZDECFSZ f,df,d
RRFRRF f,df,d
RLFRLF f,df,d
SWAPFSWAPF f,df,d
INCFSZINCFSZ f,df,d

ByteByte--OrientedOriented
OperationsOperations

© 1999 Microchip Technology Incorporated. All Rights Reserved.

PIC MCU Instruction Set
Byte-Oriented Operations

NOP No Operation
Syntax: NOP
Operands: None
Operation: No operation
Status: None
Encoding: 00 0000 0000 0000
Words: 1
Cycles: 1

Example:
NOP
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PIC MCU Instruction Set
Byte-Oriented Operations

MOVWF Move W to f
Syntax: MOVWF  f
Operands: 0 <= f <= 127
Operation: (W) -> (f)
Status: None
Encoding: 00 0000 1fff fff
Words: 1
Cycles: 1

Example:
MOVWF FSR
Before Instruction

FSR = 0xFF
W = 0x4F

After Instruction
FSR = 0x4F
W = 0x4F

© 1999 Microchip Technology Incorporated. All Rights Reserved.

PIC MCU Instruction Set
Byte-Oriented Operations

CLRW Clear W
Syntax: CLRW
Operands: None
Operation: 00h -> (W)

1 -> Z
Status: Z
Encoding: 00 0001 0000 0000
Words: 1
Cycles: 1

Example:
CLRW
Before Instruction

W = 0x4F

After Instruction
W = 0x00
Z = 1
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PIC MCU Instruction Set
Byte-Oriented Operations

SUBWF Subtract W from f
Syntax: SUBWF  f,d
Operands: 0 <= f <= 127

d = {0,1}
Operation: (f) - (W) -> dest
Status: C,DC,Z
Encoding: 00 0010 dfff ffff
Words: 1
Cycles: 1

Example:
SUBWF   FSR,W
Before Instruction

FSR = 0x03
W = 0x02
C = ?
Z = ?

After Instruction
FSR = 0x03
W = 0x01
C = 0
Z = 0

© 1999 Microchip Technology Incorporated. All Rights Reserved.

PIC MCU Instruction Set
Byte-Oriented Operations

DECF Decrement f
Syntax: DECF  f,d
Operands: 0 <= f <= 127

d = {0,1}
Operation: (f) - 1 -> dest
Status: Z
Encoding: 00 0011 dfff ffff
Words: 1
Cycles: 1

Example:
DECF   FSR,F
Before Instruction

FSR = 0x01
Z = 0

After Instruction
FSR = 0x00
Z = 1
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PIC MCU Instruction Set
Byte-Oriented Operations

ANDWF AND W with f
Syntax: ANDWF  f,d
Operands: 0 <= f <= 127

d = {0,1}
Operation: (W).AND.(f) -> dest
Status: Z
Encoding: 00 0101 dfff ffff
Words: 1
Cycles: 1

Example:
ANDWF  CNT,F
Before Instruction

CNT = B’00010111’
W = B’11000010’

After Instruction
CNT = B’00000010’
W = B’11000010’
Z = 0

© 1999 Microchip Technology Incorporated. All Rights Reserved.

PIC MCU Instruction Set
Byte-Oriented Operations

XORWF Exclusive OR W & f
Syntax: XORWF  f,d
Operands: 0 <= f <= 127

d = {0,1}
Operation: (W).XOR.(f) -> dest
Status: Z
Encoding: 00 0110 dfff ffff
Words: 1
Cycles: 1

Example:
XORWF  FSR,W
Before Instruction

FSR = B’10101111’
W = B’10110101’

After Instruction
FSR = B’10101111’
W = B’00011010’
Z = 0
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PIC MCU Instruction Set
Byte-Oriented Operations

MOVF Move f
Syntax: MOVF  f,d
Operands: 0 <= f <= 127

d = {0,1}
Operation: (f) -> dest
Status: Z
Encoding: 00 1000 dfff ffff
Words: 1
Cycles: 1

Example:
MOVF  FSR,F
Before Instruction

FSR = 0x00
Z = 0

After Instruction
FSR = 0x00
Z = 1

© 1999 Microchip Technology Incorporated. All Rights Reserved.

PIC MCU Instruction Set
Byte-Oriented Operations

INCF Increment f
Syntax: INCF  f,d
Operands: 0 <= f <= 127

d = {0,1}
Operation: (f) + 1 -> dest
Status: Z
Encoding: 00 1010 dfff ffff
Words: 1
Cycles: 1

Example:
INCF  REG,F
Before Instruction

REG = 0xFF
Z = 0

After Instruction
REG = 0x00
Z = 1
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PIC MCU Instruction Set
Byte-Oriented Operations

DECFSZ Dec. f, Skip if 0
Syntax: DECFSZ  f,d
Operands: 0 <= f <= 127

d = {0,1}
Operation: (f) - 1 -> dest

skip if result = 0
Status: None
Encoding: 00 1011 dfff ffff
Words: 1
Cycles: 1(2)

Example:
Loop DECFSZ  CNT,F

GOTO Loop
Continue

Before Instruction
PC = address Loop

After Instruction
CNT = CNT - 1
if CNT = 0,
PC = address Continue
if CNT != 0,
PC = address Loop+1
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PIC MCU Instruction Set
Byte-Oriented Operations

SWAPF        Swap Nibbles in f
Syntax:         SWAPF  f,d
Operands:    0 <= f <= 127

d = {0,1}
Operation:    f<3:0> -> dest<7:4>

f<7:4> -> dest<3:0>
Status:          None
Encoding:     00 1110 dfff ffff
Words: 1
Cycles: 1

Example:
SWAPF REG,W

Before Instruction
REG = 0xA5

After Instruction
REG = 0xA5
W = 0x5A



27

© 1999 Microchip Technology Incorporated. All Rights Reserved.

PIC MCU Instruction Set
Byte-Oriented Operations

INCFSZ Inc. f, Skip if 0
Syntax: INCFSZ  f,d
Operands: 0 <= f <= 127

d = {0,1}
Operation: (f) + 1 -> dest

skip if result = 0
Status: None
Encoding: 00 1111 dfff ffff
Words: 1
Cycles: 1(2)

Example:
Loop INCFSZ  CNT,F

GOTO Loop
Continue

Before Instruction
PC = address Loop

After Instruction
CNT = CNT + 1
if CNT = 0,
PC = address Continue
if CNT != 0,
PC = address Loop+1
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PIC MCU Instruction Set
Bit-Oriented Operations

1414--bit Instruction for Bit Oriented Operationsbit Instruction for Bit Oriented Operations

OP CODEOP CODE bb ff ff ff ff ff ff ff

b = 3b = 3--Bit AddressBit Address
(Bit Number)(Bit Number)

f = 7f = 7--bit Register Addressbit Register Address

bb bb

Example:Example:

BTFSCBTFSC STATUS, CSTATUS, C
BTFSCBTFSC f, bf, b

BCFBCF f,bf,b
BSFBSF f,bf,b
BTFSCBTFSC f,bf,b
BTFSSBTFSS f,bf,b

BitBit--OrientedOriented
OperationsOperations
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PIC MCU Instruction Set
Bit-Oriented Operations

BCF Bit Clear f
Syntax: BCF  f,b
Operands: 0 <= f <= 127

0 <= b <= 7
Operation: 0 -> (f<b>)
Status: None
Encoding: 01 00bb bfff ffff
Words: 1
Cycles: 1

Example:
BCF  FSR,4
Before Instruction

FSR = 0011 0000

After Instruction
FSR = 0010 0000
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PIC MCU Instruction Set
Bit-Oriented Operations

BSF Bit Set f
Syntax: BSF  f,b
Operands: 0 <= f <= 127

0 <= b <= 7
Operation: 1 -> (f<b>)
Status: None
Encoding: 01 01bb bfff ffff
Words: 1
Cycles: 1

Example:
BSF  FSR,4
Before Instruction

FSR = 0010 0000

After Instruction
FSR = 0011 0000
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PIC MCU Instruction Set
Bit-Oriented Operations

BTFSC Bit Test f, Skip if 0
Syntax: BTFSC  f,b
Operands: 0 <= f <= 127

0 <= b <= 7
Operation: skip if (f<b>) = 0
Status: None
Encoding: 01 10bb bfff ffff
Words: 1
Cycles: 1(2)

Example:
Here BTFSC    CNT,1
False GOTO Done
True

Before Instruction
PC = address Here

After Instruction
if CNT<1> = 0,
PC = address True
if CNT<1> = 1,
PC = address False
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PIC MCU Instruction Set
Bit-Oriented Operations

BTFSS Bit Test f, Skip if 1
Syntax: BTFSS  f,b
Operands: 0 <= f <= 127

0 <= b <= 7
Operation: skip if (f<b>) = 1
Status: None
Encoding: 01 11bb bfff ffff
Words: 1
Cycles: 1(2)

Example:
Here BTFSS    CNT,1
False GOTO Done
True

Before Instruction
PC = address Here

After Instruction
if CNT<1> = 1,
PC = address True
if CNT<1> = 0,
PC = address False
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PIC MCU Instruction SetPIC MCU Instruction Set
Example: Bit ManipulationExample: Bit Manipulation

XMIT:XMIT: MOVLWMOVLW 0x08    0x08    ;Bit count = 8;Bit count = 8
MOVWF    MOVWF    bit_count  bit_count  

XM_LOOP: XM_LOOP: 
BCFBCF PORTB,DTPORTB,DT ;preset clock & data lines to 0 ;preset clock & data lines to 0 
BCFBCF PORTB,CLKPORTB,CLK ;preset clock & data lines to 0 ;preset clock & data lines to 0 
RRFRRF XDATA,F    XDATA,F    ;rotate data right thru Carry;rotate data right thru Carry
BTFSCBTFSC STATUS,C STATUS,C ;test carry bit ;test carry bit 
BSFBSF PORTB,DTPORTB,DT ;set 1 ;set 1 Data pin Data pin 
BSFBSF PORTB,CLKPORTB,CLK ;set 1 ;set 1 Clock pinClock pin
DECFSZDECFSZ bit_count,Fbit_count,F ;decrement count;decrement count
GOTOGOTO XM_LOOPXM_LOOP ;Not done then repeat;Not done then repeat
BCFBCF PORTB,CLKPORTB,CLK ;clear clock line and exit;clear clock line and exit

Synchronous serial transmission of eight bits of data from file 
register XDATA to I/O Pin:

ClockClock

DataData

00 11 77
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PIC MCU Instruction Set
Literal Operations

kk

1414--bit Instruction for Literal Operationsbit Instruction for Literal Operations

OP CODEOP CODE kk kk kk kk kk kk kk

k = 8k = 8--bit Immediate Valuebit Immediate Value

Example:Example:

MOVLWMOVLW 0x2F0x2F
MOVLWMOVLW kk

MOVLWMOVLW kk
IORLWIORLW kk
ADDLWADDLW kk
SUBLWSUBLW kk
ANDLWANDLW kk
XORLWXORLW kk

LiteralLiteral
OperationsOperations
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PIC MCU Instruction Set
Literal Operations

MOVLW Move Literal to W
Syntax: MOVLW  k
Operands: 0 <= k <= 255
Operation: k -> (W) 
Status: None
Encoding: 11 0000 kkkk kkkk
Words: 1
Cycles: 1

Example:
MOVLW  0x5A

After Instruction
W = 0x5A
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PIC MCU Instruction Set
Literal Operations

SUBLW Subtract W from Literal
Syntax: SUBLW  k
Operands: 0 <= k <= 255
Operation: k - (W) -> (W)
Status: C,DC,Z
Encoding: 11 1100 kkkk kkkk
Words: 1
Cycles: 1

Example:
SUBLW  0x02

Before Instruction
W = 2
C = ?
Z = ?

After Instruction
W = 0x00
C = 0
Z = 1
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PIC MCU Instruction Set
Literal Operations

ANDLW AND Literal with W
Syntax: ANDLW  k
Operands: 0 <= k <= 255
Operation: (W) .AND. k -> (W)
Status: Z
Encoding: 11 1001 kkkk kkkk
Words: 1
Cycles: 1

Example:
ANDLW  B’01011111’

Before Instruction
W = B’10100011’

After Instruction
W = B’00000011’
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PIC MCU Instruction Set
Literal Operations

XORLW       Exclusive OR Literal with W
Syntax:        XORLW  k
Operands:   0 <= k <= 255
Operation:   (W) .OR. k -> (W)
Status:         Z
Encoding:    11 1010 kkkk kkkk
Words:         1
Cycles:         1

Example:
XORLW  B’10101111’

Before Instruction
W = B’10110101’

After Instruction
W = B’00011010’
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PIC MCU Instruction Set
Control Operations

kk

1414--bit Instruction for RETLWbit Instruction for RETLW

OP CODEOP CODE kk kk kk kk kk kk kk

k = 8k = 8--bit Immediate Valuebit Immediate Value

SLEEPSLEEP --
CLRWDTCLRWDT --
RETLWRETLW kk
RETFIERETFIE --
RETURNRETURN --
CALLCALL kk
GOTOGOTO kk

ControlControl
OperationsOperations

1414--bit Instruction for CALL and GOTObit Instruction for CALL and GOTO

OP CODEOP CODE

k = 11k = 11--bit Immediate Valuebit Immediate Value

kk kk kk kk kk kk kk kk kk kk kk
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PIC MCU Instruction Set
Control Operations

SLEEP Enter SLEEP mode
Syntax: SLEEP
Operands: None
Operation: 00h -> WDT

1 -> TO
0 -> PD

Status: TO, PD
Encoding: 00 0000 0110 0011
Words: 1
Cycles: 1

Example:
SLEEP
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CLRWDT Clear Watchdog
Syntax: CLRWDT
Operands: None
Operation: 00h -> WDT

0 -> WDT prescaler
1 -> TO
1 -> PD

Status: TO, PD
Encoding: 00 0000 0110 0100
Words: 1
Cycles: 1

PIC Instruction Set
Control Operations

Example:
CLRWDT
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PIC MCU Instruction Set
Control Operations

RETLW Return with Literal in W
Syntax: RETLW  k
Operands: 0 <= k <= 255
Operation: k -> (W)

TOS -> PC 
Status: None
Encoding: 11 0100 kkkk kkkk
Words: 1
Cycles: 2

Example:
RETLW  0x5A

After Instruction
W = 0x5A
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PIC MCU Instruction Set
Control Operations

RETFIE Return from Interrupt
Syntax: RETFIE
Operands: None
Operation: TOS -> PC

1 -> GIE 
Status: None
Encoding: 00 0000 0000 1001
Words: 1
Cycles: 2

Example:
RETFIE
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PIC MCU Instruction Set
Control Operations

RETURN Return from Subroutine
Syntax: RETURN
Operands: None
Operation: TOS -> PC 
Status: None
Encoding: 00 0000 0000 1000
Words: 1
Cycles: 2

Example:
RETURN
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PIC MCU Instruction Set
Control Operations

CALL Call Subroutine
Syntax: CALL k
Operands: 0 <= f <= 2047
Operation: (PC) + 1 -> TOS

k -> PC<10:0>
PCLATH<4:3 ->
PC<12:11>

Status: None
Encoding: 10 0kkk kkkk kkkk
Words: 1
Cycles: 2

Example:
Here CALL There

Before Instruction
PC = address Here

After Instruction
PC = address There
TOS = address Here+1
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PIC MCU Instruction Set
Control Operations

GOTO Unconditional Branch
Syntax: GOTO k
Operands: 0 <= f <= 2047
Operation: k -> PC<10:0>

PCLATH<4:3> ->
PC<12:11>

Status: None
Encoding: 10 1kkk kkkk kkkk
Words: 1
Cycles: 2

Example:
GOTO There

After Instruction
PC = address There



37

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Assembler Directives Assembler Directives 

LIST 
– Syntax: list [<list_option>,…list_option>]
– Ex:   list p=16F84A, f=INHX8M, r=DEC
– Description: Select various assembler options

INCLUDE
– Syntax:  include “filename.*” or <filename.*>
– Ex:   include <p16f84a.inc>
– Description:  Assembles the indicated file as if it were in-line 

code in the source file.  Commonly used to create modular 
code segments.
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Assembler DirectivesAssembler Directives

ORG
– Syntax: ORG   <address>
– Ex: ORG 0x00
– Description: Start assembling the lines below this statement 

at location 0x00.

EQU
– Syntax: <label> equ <expr>
– Ex: SECONDS equ 0x24
– Description: Define a text substitution for a constant or 

variable.  Seconds is a constant of 24h or is a register @ 
address 0x24.
– movlw SECONDS ;const = 24h
– movf SECONDS,W ;value in seconds reg.
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Assembler DirectivesAssembler Directives

CBLOCK
– Syntax: cblock [<expr>]
– Example: 

cblock 0x20    ;Start point of cblock
hours 
minutes 
seconds
halfseconds:2

endc ;Indicates end of cblock
– Description: Declare Symbol Constant

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Assembler Directives (cont)Assembler Directives (cont)

END 
– Syntax:  end   
– Example: Indicates end of source code.

You must have this statement after the last instruction 
you want assembled.
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RelocatableRelocatable CodeCode
What is it?What is it?

Code written to work at any address

In source, code and data are organized into blocks called 
‘sections’

The linker assigns sections into memory regions
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RelocatableRelocatable CodeCode
Why use it?Why use it?

Organization - You can organize your project into multiple files

Reusability - Source files can have a more focused purpose, 
encouraging code reuse

Faster Development - Recompilation of entire project is not required 
each time a change is made

Convenience - User does not need to organize and manage individual 
memory locations
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RelocatableRelocatable CodeCode
In MPASMIn MPASM

CODE - Declares the beginning of a program code section

UDATA - Declares the beginning of an uninitialized data section

BANKSEL - Selects the correct bank for a RAM access

PAGESEL - Selects the correct bank for a ROM access

EXTERN - Indicates a variable that is declared in another module

GLOBAL - Indicates that a variable is referenced in another module

© 1999 Microchip Technology Incorporated. All Rights Reserved.
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Unique Tool SupportUnique Tool Support

ProjectProject
ManagerManager

BuiltBuilt--in in 
EditorEditor

Source LevelSource Level
DebuggerDebugger

MPASMMPASM
AssemblerAssembler

C CompilersC Compilers

LanguagesLanguages ProgrammersProgrammers

MPLABMPLAB--SIMSIM
SimulatorSimulator

SimulatorsSimulators

RealReal--ICEICE
MPLABMPLAB--ICEICE
2000 & 40002000 & 4000

Emulators/Emulators/
DebuggersDebuggers

Third PartyThird Party

Other toolsOther tools

MPLINKMPLINK
MPLIBMPLIB

SIMICESIMICE
HardwareHardware
SimulatorSimulator

MPLABMPLAB™™
Integrated Development EnvironmentIntegrated Development Environment

PICSTARTPICSTART®®

PlusPlus
PICKIT 2PICKIT 2

PRO PRO MATEMATE®®IIII
PM 3PM 3

MPLABMPLAB--ICD2ICD2
PICkitPICkit 22
ExpressExpress
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Development SystemsDevelopment Systems
MPLABMPLAB--ICEICE

Universal in-circuit emulator for PIC® MCUs
Windows™ compatible 
MPLAB compatible
Parallel port interface
Complete source-level debugging
Real-time in-circuit emulation of PIC MCUs
Low voltage emulation
Program memory emulation and memory mapping up to 64K words



42

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Development SystemsDevelopment Systems
MPLABMPLAB--ICE ICE (continued)(continued)

Break/trace/trigger on program address/data, internal register 
address/data, external inputs, or bus cycle type (mid-range, hi-end, 
golden gate only)
Real-time trace with up to 32K x 128 buffer
Time stamp trace
External trigger input and output for logic analyzer/scope interface 
Complex breakpoints of up to four levels. Sequential events, 
AND/OR events, filtered trace, time between two events, and pass
counts.
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MPLABMPLAB--ICE 2000ICE 2000

Host to Pod Cable
*Emulator Pod

*Processor
Module

Flex Circuit
Cable

*Device 
Adapter

*SOIC
Transition
Socket

*Each component *Each component 
ordered separatelyordered separately
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Development SystemsDevelopment Systems
ICEPICICEPIC

Low cost in-circuit emulator for PIC MCUs
Developed by RF Solutions (U.K.)
Windows-compatible
Complete source-level debugging
EIA232 serial interface
Unlimited breakpoints
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Development SystemsDevelopment Systems
MPLABMPLAB--SIMSIM

Universal simulator for PIC MCUs
Windows and MPLAB-compatible
Discrete event instruction-based simulation
Complete source-level debugging
Support interrupts and most peripheral functions (not A/D or serial 
I/O)
Stimulus injection and file input capability
Free
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Development SystemsDevelopment Systems
MPLABMPLAB--ICD 2ICD 2

Features
• USB (Full Speed 2 M bits/s) & RS-232 interface to host 

PC 
• Real time background debugging 
• MPLAB IDE GUI (free copy included) 
• Built in over-voltage/short circuit monitor 
• Firmware upgradeable from PC 
• Totally enclosed 
• Supports low voltage to 2.0 volts. (2.0 to 6.0 range) 
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Development SystemsDevelopment Systems
MPLABMPLAB--ICD 2ICD 2

Features Continued
• Diagnostic LEDs (Power, Busy, Error) 
• Reading/Writing memory space and EEDATA areas of 

target microcontroller 
• Programs configuration bits 
• Erase of program memory space with verification 
• Peripheral freeze-on-halt stops timers at breakpoints
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Development SystemsDevelopment Systems
MPLABMPLAB--ICD 2ICD 2

There is some shared overhead expense that 
includes:

• one stack level, 
• some general purpose file registers
• a small area of program memory when in the debug 

mode
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Development SystemsDevelopment Systems
PICSTARTPICSTART PlusPlus

Development programmer kit

Supports all PIC MCUs

Windows- and MPLAB-compatible

CD-ROM literature
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Development SystemsDevelopment Systems
PICSTART Plus Development ProgrammerPICSTART Plus Development Programmer

Upgrades done in MPLAB software -
firmware upgrades occasionally 
required for new PIC sub-families
Uses serial programming algorithms 
for all ICSP® capable devicesPICSTART PICSTART PlusPlus

DEVELOPMENT PROGRAMMERDEVELOPMENT PROGRAMMER

POWERPOWER
ACTIVEACTIVE

RSRS--232 Serial 232 Serial 
InterfaceInterface 9V DC Input9V DC Input

Power ONPower ON
ProgrammerProgrammer
ActiveActive

4040--Pin ZIF Socket to accommodate Pin ZIF Socket to accommodate PICsPICs
from 8from 8-- to 40to 40--pins.  68pins.  68--pin PLCC can be pin PLCC can be 
programmed with an adapterprogrammed with an adapter

PinPin--11
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Development SystemsDevelopment Systems
PRO MATEPRO MATE®® IIII

Universal device programmer for PIC MCUs
Stand-alone or PC DOS-compatible, 
MPLAB-compatible
EIA232 PC host interface
Interchangeable socket modules
Environment “save and restore”
Programmable voltages for verify
Serialized programming capabilities
ICSP support
Serial EEPROM support
KEELOQ® support
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Development SystemsDevelopment Systems
PICDEMPICDEM--1, 1, --2, 2, --3, 3, --14, 14, --1717

Demonstration board for PIC MCUs
On board +5V regulator
EIA232 interface
5K pot to simulate analog input
3 push buttons for external stimulus and reset
LED’s connected to PORTB
LCD display panel connection
Socket for crystal oscillator
Prototype area
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Development SystemsDevelopment Systems
PICDEMPICDEM--1 Demo Board1 Demo Board

Demo board     
accommodates all 18-pin    
PIC devices, 28-pin 
PIC16C5X and 40-pin  
PIC17C4X devices
8-LEDs connected to   
PORTB
5kΩ Pot connected to AN0
PB switches connected    
to RA1, RTCC, and MCLR

LED

RS-232
Serial Interface

Crystal Oscillator
Socket

9V DC Input

Prototyping
Area

Potentiometer
on A/D Channel 0

RTCC
MCLR

RA1

RS-232 Level
Shifter (MAX-232)
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Development SystemsDevelopment Systems
MPASMMPASM

Universal macro assembler for all PIC MCUs
DOS- and Windows-compatible
Compatible with MPLAB
– Symbolic and source-level debugging
– Can generate relocatable code

Multiple output formats
Licensed by several third party vendors
Free

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Development SystemsDevelopment Systems
COMPILERSCOMPILERS

Microchip MPLAB-C17

Microchip MPLAB-C18

Microchip MPLAB-C30

Hi-Tech

CCS

IAR

Byte Craft

Micro Engineering Labs (Basic)
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Development SystemsDevelopment Systems
Reference MaterialsReference Materials

Application notes
– Embedded Controls Handbook

Reference designs
Website
– http://www.microchip.com
– Conference groups
– Mailing lists

Microchip CD ROM
Template subdirectory under MPLAB (code templates)
Seminars
Workshops
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Development SystemsDevelopment Systems
Third Party GuideThird Party Guide

Microchip encourages third-party support

– 312-page reference manual to aid in selection of appropriate tools

– 106 companies and 208 products

– Emulators

– Programmers and gang programmers

– ‘C’ compilers, software, demo boards, etc.

– Design consultant reference
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Books For Further ResearchBooks For Further Research
(English)(English)

Design with PIC Microcontrollers, John Peatman, 
Prentice-Hall, 0-13-759259-0
Programming and Customizing the PIC Microcontroller, Myke Predko, McGraw-
Hill, 0-07-913646-X
Easy PIC’n, David Benson, Square 1 Electronics,  
0-9654162-0-8
PIC’n Up The Pace, David Benson, Square 1 Electronics, 
0-9654162-1-6
A Beginners Guide to the Microchip PIC, Nigel Gardner, Bluebird Technical 
Press Ltd., 1-899013-01-6
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Books For Further ResearchBooks For Further Research
(English)(English)

PIC Cookbook Vol 1 & Vol 2, Nigel Gardner, Bluebird Technical Press Ltd., 
1899013-02-4,         
1-901631-00-1
The Greatest Little PIC Book, Gordon McNee, Bluebird Technical Press Ltd., 1-
901631-01-X
PIC Microcontroller Operation and Applications, 
DN de Beer, Cape Technikon, daandb@norton.ctech.az.za
Getting started with PIC Microcontrollers, Al Stevens, Ziggurat Technologies, 
ziggurat@global.co.za
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Books For Further ResearchBooks For Further Research
(French)(French)

Les Microcontrolleurs PIC et mise en oeuvre, Christian Tavernier, Dunod, 2-10-
002647-X
Micontrolleurs PIC a structure RISC, C.F. Urbain, 
Publitronic, 2-86661-058-X
Pratique des Microcontroleurs PIC, Francesco 
Volpe/Safinaz Volpe, Publitronic Elektor, 2-86661-077-6
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Books For Further ResearchBooks For Further Research
(German)(German)

Mit dem PIC-Controller Erfolgreich Arbeiten, Dr. Anne Koenig/Manfred Koenig, 
Markt & Technik Verlag, 
3-8272-5168-0
Mikrokontroller mit RISC Struktur, C.F. Urbain, Elektor Compact, 3-928051-83-0
Mikroprozessor PIC16C5X, Michael Rose, Huthig, 
3-7785-2169-1
Mikroprozessor PIC17C42, Michael Rose, Huthig, 
3-7785-2170-5
PIC uC Praxis, Francesco Volpe/Safinaz Volpe, Elektor Verlag, 3-89576-030-7
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Books For Further ResearchBooks For Further Research
(Italian/Russian/Spanish)(Italian/Russian/Spanish)

La Programmazione dei Microcontrollori PIC, Andrea Sbrana, Italy +39 544 
464070
New Possibilities with the Microchip PIC, RIGA, Latvia +371 935 0550
MicroControladores PIC La Solution en un Chip, Martinez Usategui, 
Paraninfo,84-283-2371-2
MicroControladores PIC, Christian Tavernier, Paraninfo, 84-283-2373-9
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Books For Further ResearchBooks For Further Research
(Chinese)(Chinese)

Parts 1-5 PIC16C5X/71/84 Development and Design, United Tech 
Electronic Co. Ltd, 
– 957-21-0807-7
– 957-21-1152-3
– 957-21-1187-6
– 957-21-1251-1
– 957-21-1257-0

PIC16C84 MCU Architecture and Software Development, ICC 
Company, 957-8716-79-6
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Microchip Technical ServicesMicrochip Technical Services
Engineering Web SiteEngineering Web Site

Web address: www.microchip.com
Latest versions available
– Datasheets
– User’s Guides
– Application Notes
– Device Errata 
– Development tools

Frequently-Asked Questions (FAQs)
Latest product announcements
Recent press releases

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Microchip Technical ServicesMicrochip Technical Services

Workshops
– Hands on workshops using 

Microchip development tools
– Various topics in many cities
– Watch the web site for details

Address:  www.microchip.com
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On to the LabsOn to the Labs

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Lab 1Lab 1

PIC12C672PIC12C672
1414--bit corebit core
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Lab1Lab1

Objective: 
Program an OTP and plug it into your PIC & Stick take 
home demo board
– 1st time experience with tools 
– Will use PIC & Stick board with non-coded PIC’s

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Lab 1Lab 1
MPLAB LayoutMPLAB Layout

Development Mode

Target Processor

Run Halt Step ResetMake
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Lab 1Lab 1
Selecting Hardware OptionsSelecting Hardware Options

Use Debugger > Select Tool > MPLAB SIM… to select 
execution environment

Use Configure > Select Device to select processor 

Use Debugger > Settings > Clock TAB to select oscillator 
frequency
– MPLAB-ICE uses a programmable clock
– MPLAB-SIM only uses frequency for time calculations
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Lab 1Lab 1
MPLAB ProjectsMPLAB Projects

MPLAB projects manage:

– Installed build tools

– Development mode

– Hardware settings

– Source files

– Dependencies (*.inc, *.h)

– Compile, link, and assembly options
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Lab 1Lab 1
Creating a New ProjectCreating a New Project

Choose Project > New Project… from the menu, and select 
a filename for your project

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Lab 1Lab 1
Setting Build OptionsSetting Build Options
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Lab 1Lab 1
Configuring Build ToolsConfiguring Build Tools

Microchip’s tools are configured for use during installation
For other tools, use Project > Select Language Tool Suite...

Use the Active Toolsuite: pulldown bar for other Language 
toolsuites

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Lab 1Lab 1
Using the Project WindowUsing the Project Window

Quick access to project summary
– Source files
– Dependencies
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Setting Up MPLAB IDE Projects Setting Up MPLAB IDE Projects 
Program Your PartProgram Your Part

Verify that your program is listed in the “Program Memory 
Window”
If it is not, build your project again to update the “Program 
Memory Window”
Verify device settings in the PICSTART Plus Device 
Programmer window
Insert part to be programmed with correct pin 1 orientation
Click on Program to program part

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Lab notesLab notes

Must make a project first, prior to programming part
Make sure that the .asm file is listed in the project as a file 
to be built
Must build the .asm file to create a .hex file prior to 
programming part
Make sure that correct part is selected on programmer
Must set configuration bits for the operating mode of the 
part
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What feature set (reminder)What feature set (reminder)

– Open/close
– Switch controlled
– Held open to allow passage thru door
– Automatic close (store type) 
– Safety cutoffs (if time permits)
– Independent motor control (if time permits)
– Double tap (if time permits)
– Lighting control (optional)
– Sound control* (optional)
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Lab 2Lab 2

Using An I/O Port (Switching)Using An I/O Port (Switching)
PIC12F508PIC12F508
1212--bit Corebit Core
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Lab notes:Lab notes:
Peripheral Used:Peripheral Used: Digital I/O PortsDigital I/O Ports

6 - 20 I/O pins 
Each I/O pin software configurable as input or output
Direct bit manipulation (single-word/single-cycle):

Bit set
Bit clear

High drive capability
– 25mA sink max (all parts)
– 60mA sink max (PIC17CXXX)
– 25mA source max

Can directly drive LEDs:

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Data Bus

Wrt. Port

D

Q

Q
SET

CLR

D

Q

Q
SET

CLR

W Reg

Tris f

Rd. Port

I/O Pin
Data Latch

Tris Latch

Vss

Vdd

Reset

Peripherals:Peripherals:
Digital I/O Port (Cont.)Digital I/O Port (Cont.)
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Lab Notes: Lab Notes: 
ReadRead--ModifyModify--WriteWrite

PC PC + 1 PC + 2 PC + 3

Q1 Q2 Q3 Q4 Q1 Q2 Q3 Q4 Q1 Q2 Q3 Q4 Q1 Q2 Q3 Q4

Instruction
fetched

RB7:RB0

MOVWF PORTB
write to
PORTB

NOP

Port pin
sampled here

NOP
MOVF PORTB,W

Instruction
executed

MOVWF PORTB
write to
PORTB

NOP
MOVF PORTB,W

PC

TPD

Note:

This example shows a write to PORTB
followed by a read from PORTB.

Note that:
data setup time = (0. 25TCY-TPD )

where TCY= instruction cycle
TPD = propagation delay

Therefore, at higher clock frequencies,
a write followed by a read may be problematic.

Consider loads on pins for back to back read-modify-writes

Qcy = Fosc
Instruction cycle = Fosc/4

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Workshop Board Schematic (excerpt)Workshop Board Schematic (excerpt)
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Lab2 Using An I/O PortLab2 Using An I/O Port

Objective: 
Drive port pin GP4 to a logic 1 
Verify code with the MPLAB Simulator
Program a part and test it in your workshop board

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Make a project file reviewMake a project file review
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Setting Up MPLAB IDE ProjectsSetting Up MPLAB IDE Projects
Make A .Make A .asmasm FileFile

File -> New
– This opens a text window where you can begin entering your code

Type in program header
File -> Save As
– Save the file as lab2.asm

File -> Close

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Setting Up MPLAB IDE ProjectsSetting Up MPLAB IDE Projects
Make A Project FileMake A Project File

Project -> New
– Type Lab2 in Project Name Box
– Click Browse: Find Folder: C:\PIC101 Click the Select button

– Click on OK
– Project Files

– Right Click on Source files
– Select Add Files
– Find Lab2.asm Click Open
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Setting Up MPLAB IDE ProjectsSetting Up MPLAB IDE Projects
Make A Project File (cont.)Make A Project File (cont.)

– Project Files Continued
– Right Click on Header files

– Select Add Files
– Find c:\Program Files\MPLAB 

IDE\MCHIP_tools\P12C508A.inc

– Click Open
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Setting Up MPLAB IDE Projects Setting Up MPLAB IDE Projects 
Make A Project File (cont.)Make A Project File (cont.)

– Project Files cont.
– Debugger > Select Tool > MPLAB SIM
– Configure > Select Device

– Use Device: pull down Bar
– Select the appropriate part [12C508A]
– Click on OK (Close Select Device Dialogue box)
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Setting Up MPLAB IDE Projects Setting Up MPLAB IDE Projects 
Verify Correct .Verify Correct .asmasm FileFile

Verify that the “Node: lab2.asm” file is the correct file you are working 
on.

Double click on lab2.asm in the Lab2.mcw Project window
– Lab2.asm will be used for this project

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Code Ex2 Code Ex2 -- Light an LEDLight an LED

;**********************************************************************
;This program drives a 1 onto port pin GP4
;**********************************************************************

List  P=12F508, R=hex
include <P12F508.inc>  ;load the include file
__CONFIG _IntRC_OSC & _WDT_OFF & _CP_OFF & _MCLRE_ON

org 0x00 ;indicate the start location
Start clrf GPIO ;load output latch w/zeros

movlw 0x00 ;Configure port to outputs
tris GPIO ;
bsf GPIO,4   ;set pin 4 on GPIO (GP4) to logic 1

Loop nop
goto Loop ;$ = current address... infinite loop
end
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Create a Watch WindowCreate a Watch Window

View -> Special Function Registers
View -> Watch  -> New Watch Window
– Use pull down menu to select registers/variables to watch
– Click Add FSR button after each one or Click Add Symbol button

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Use simulator to step thru the codeUse simulator to step thru the code

Debugger -> Run
– F6 Reset
– F7 Step
– F8 Step Over
– F9 Run
– F5 Halt
– Ctrl + F9 Animate
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Lab notesLab notes

Must declare org statements so assembler knows 
code/memory organization
Don’t forget to declare variables if needed
Must configure port pins prior to writing to them

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Lab3Lab3

TimingTiming
PIC12F508PIC12F508
1212--bit Corebit Core
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Lab notes:Lab notes:
Peripheral Used: TMR0Peripheral Used: TMR0

Readable and writable 
Generates interrupt on overflow from FFh to 00h
Prescaler is programmable 
In timer mode: fastest increment rate is OSC/4 
(5 MHz @ 20 MHz oscillator frequency)
In counter mode: configurable to increment on either edge
External counter mode has Max. input = 50 MHz (using prescaler)
Writing to TMR0 causes an error of 2 Tcy

Ext clockExt clock
inputinput

InternalInternal
clockclock

88--bit bit prescalerprescaler 88--bit timer/counterbit timer/counter

Interrupt on overflow Interrupt on overflow 
(not on PIC12C508A)(not on PIC12C508A)

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Timing Loop

Counting Loop

Nested Loop

Branch Control
BTFSS
BTFSC

DECFSZ
INCFSZ

Lab Notes:Lab Notes:
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OPTION REG
PIC12F508

W-1 W-1 W-1 W-1 W-1 W-1 W-1 W-1

GPWU GPPU T0CS T0SE PSA PS2 PS1 PS0 W= Writable bit
U= Unimplemented bit
- n= Value at POR reset
Reference Table4-1 for other
resets.

bit7 6 5 4 3 2 1 bit0

bit 5: T0CS: Timer0 clock source select bit
1 = Transition on T0CKI pin
0 = Transition on internal instruction cycle clock, Fosc/4

bit 4: T0SE: Timer0 source edge select bit
1 = Increment on high to low transition on the T0CKI pin
0 = Increment on low to high transition on the T0CKI pin

bit 3: PSA: Prescaler assignment bit
1 = Prescaler assigned to the WDT
0 = Prescaler assigned to Timer0

bit 2-0: PS2:PS0 : Prescaler rate select bits

000
001
010
011

100
101
110
111

1 : 2
1 : 4
1 : 8
1 : 16
1 : 32
1 : 64
1 : 128
1 : 256

1 : 1
1 : 2
1 : 4
1 : 8
1 : 16
1 : 32
1 : 64
1 : 128

Bit Value Timer0 Rate WDT Rate

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Lab3 TimingLab3 Timing

Objective
Write an approx. 2 ms delay loop program using TMR0
– Typically used to

provide timing for delaying/controlling events
provide timing for tracking events

Do not use the prescaler
Pre-load TMR0 to count 200 micro seconds
Light 2 LEDs to indicate status
− GP4 LED2 should light to indicate that your program is running
− GP5 LED1 should light when the approx. 2 ms delay has occurred

Verify using MPLAB simulator with stopwatch
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Lab notes:Lab notes:
Calculate # of TMR0 Roll Calculate # of TMR0 Roll OversOvers

Part uses a 4Mhz clock
TMR0 clocks @ a rate of Fosc/4
– if prescaler not used

TMR0 rolls over from FFh to 00h
How many counts does a s/w counter need to get approx. 2 
ms?
How many counts does a s/w counter need to get approx. 2 
ms if tmr0 only counts 200 micro seconds? 

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Code Ex3 Code Ex3 -- 2 ms delay (cont.)2 ms delay (cont.)
Set Prescaler

Light 1st LED

Reset TMR0

2
ms?

Light 2nd LED
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Lab notesLab notes

– The PIC12F508 has an 8 bit timer (TMR0) with a 
selectable prescaler (up to 8 bits)

– You may need to pre-load TMR0 to get the desired 
time

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Lab notes:Lab notes:
Sample windowSample window

What happens if the FFh -> 00h roll over occurs after you 
have sampled?
Use a Sample Window    
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Lab3 TimingLab3 Timing

Review sample code lab3.asm provided by the instructor. 

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Lab4Lab4

TimingTiming
PIC16F84APIC16F84A
1414--bit Corebit Core
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Feature Used: InterruptsFeature Used: Interrupts

RBIF
RBIE

T0IF
T0IE

INTF
INTE

GIE

EEIE

Wake - up
(If in SLEEP mode)

Interrupt to CPU

EEIF

© 1999 Microchip Technology Incorporated. All Rights Reserved.

INTCON REG
PIC16F84A

R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-x

GIE EEIE T0IE INTE RBIE T0IF INTF RBIF R= Readable bit W= Writable bit

U= Unimplemented bit, read as ‘0’
- n= Value at POR reset

bit7 bit0

bit 7: GIE: Global Interrupt Enable bit
1 = Enables all un-masked interrupts
0 = Disables all interrupts

bit 5: T0IE: TMR0 Overflow Interrupt Enable bit
1 = Enables the TMR0 interrupt
0 = Disables the TMR0 interrupt

bit 2: T0IF: TMR0 Overflow Interrupt Flag bit
1 = TMR0 has overflowed (must be cleared in software)
0 = TMR0 did not overflow
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OPTION REG
PIC16F84A

R/W-1 R/W-1 R/W-1 R/W-1 R/W-1 R/W-1 R/W-1 R/W-1

RBPU INTEDG T0CS T0SE PSA PS2 PS1 PS0 R= Readable bit W= Writable bit
U= Unimplemented bit, read as ‘0’
- n= Value at POR reset

bit7 bit0

bit 5: T0CS : TMR0 Clock Source Select bit
1 = Transition on RA4/T0CKI pin
0 = Internal instruction cycle clock (CLKOUT)

bit 4: T0SE : TMR0 Source Edge Select bit
1 = Increment on high-to-low transition on RA4/T0CKI pin
0 = Increment on low-to-high transition on RA4/T0CKI pin

bit 3: PSA : Prescaler Assignment bit
1 = Prescaler assigned to the WDT
0 = Prescaler assigned to TMR0

bit 2-0: PS2:PS0 : Prescaler Rate Select bits

000
001
010
011
100
101
110
111

1 : 2
1 : 4
1 : 8
1 : 16
1 : 32
1 : 64
1 : 128
1 : 256

1 : 1
1 : 2
1 : 4
1 : 8
1 : 16
1 : 32
1 : 64
1 : 128

Bit Value TMR0 Rate WDT Rate

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Workshop Board Schematic (excerpt)Workshop Board Schematic (excerpt)
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Why InterruptsWhy Interrupts

Better use of CPU resource
Faster response time
Multi-tasking
Fixed or known interval handler
Exception handler

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Lab notes:Lab notes:
Interrupt Service Routines;Interrupt Service Routines;

Context ChangesContext Changes

Push macro

movwf W_TEMP ;push W and STATUS
swapf STATUS,W ;
movwf STATUS_TEMP ;

endm

Pop macro
swapf STATUS_TEMP,W ;pop W and STATUS
movwf STATUS ;
swapf W_TEMP,F ;
swapf W_TEMP,W ;

endm
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Lab4 TimingLab4 Timing

Objective
Write an approx. 2 second delay loop program using TMR0 
and interrupts
– typically used to

provide timing for delaying/controlling events
provide timing for tracking events

Use prescaler
Light 2 LEDs to indicate status
− RB2 LED1 should light to indicate that your program is running
− RB3 LED2 should light when the approx. 2 sec delay has occurred

Verify using MPLAB simulator and on your workshop board 
when finished
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Lab notes:Lab notes:
Calculate # of TMR0 Roll Calculate # of TMR0 Roll OversOvers

Part uses a 4Mhz clock
TMR0 clocks @ a rate of Fosc/4
– if prescaler not used

TMR0 rolls over from FFh to 00h
Prescaler set to max
How many counts does a s/w counter need to get approx. 2 
sec.?
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Code Ex4 Code Ex4 -- 2 sec delay (cont.)2 sec delay (cont.)

Set Prescaler Light 1st led

Reset TMR0

Wait for
Interrupt

Light 2nd led

Setup Interrupts

What
caused Int

ISR

2
sec?

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Lab notesLab notes

– The 16F84A has an 8 bit timer (TMR0) with a 
selectable prescaler (up to 8 bits)

– You may need to pre-load TMR0 to get the desired 
time

– The main program should be an endless loop (goto
$)

– The interrupt vector is address 0x04
– Assert RB3 in the Interrupt Service Routine as status 

indicator
– Keep ISR as simple as possible. Fill with calls as 

needed.
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Lab4 TimingLab4 Timing

Review sample code lab4.asm provided by the instructor. 

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Lab5Lab5

Motor ControlMotor Control
PIC16F84APIC16F84A
1414--bit Corebit Core
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Motor Connection SchematicMotor Connection Schematic
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Lab5 apply to simple motor controlLab5 apply to simple motor control

Objective
Apply labs 2 and 4 to control door motors
Motor control to drive doors  both open and close
Toggle opening and closing of door in a repeating cycle
Validate using MPLAB simulator, your workshop board, and 
the scale model prototype when finished
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Lab notesLab notes

Motor biasing is set for standard logic
2 control bits are required for each motor
You will need to stop the motion of the motor before 
reversing it’s direction to avoid stripping motor’s gears
Use the timing and I/O port control modules you developed 
earlier to help you 
PORTA is tied to the 2 door motors

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Lab 6 Lab 6 
Sensing an InputSensing an Input

PIC16F84APIC16F84A
1414--bit Corebit Core
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Lab6 add sensing/inputs (2 part lab)Lab6 add sensing/inputs (2 part lab)

Mechanical catch/releases vs electrical switches
Floor pad/wall switch
Input techniques
– polling
– external interrupt on INT pin
– interrupt/wake up on change
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Input techniquesInput techniques

Polling
– sample window roll over
– power consumed
– ringing input
– debouncing of input signal

External interrupt on INT pin
– multiple interrupts
– sequential servicing
– simultaneous interrupts

Interrupt/wake up on change
– can put part to sleep prior to receiving interrupt input
– battery type apps
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Lab 6 (a) Lab 6 (a) 
Polling Input PinPolling Input Pin

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Why Why DebounceDebounce??

Ringing inputs
Noisy inputs
Glitch on input
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DebounceDebounce push button/keypush button/key
Ringing or noisy inputsRinging or noisy inputs

AN 566 contains debounce

Check_key
;poll for key press

btfsc PORTB,1 ;
goto Check_key ;

; call Debounce_delay ;debounce signal
btfsc PORTB,1 ;check for bouncing input
goto Check_key ;
return

;routine to give delay for key bounce routine
Debounce_delay

.

.
delay routine here
.
return

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Polling Input SchematicPolling Input Schematic
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Lab 6 (a) of 2Lab 6 (a) of 2--step labstep lab

Objective
Read input by polling, (foot pad) to activate door 
“opening/closing sequence” module you developed earlier
Momentary switch on port pin RB1
RB1 is an active low input
Validate using MPLAB simulator, your workshop board, and 
scale model prototype when finished
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Code Ex6a Code Ex6a -- Polling InputPolling Input

Set Prescaler

Reset TMR0

Wait for
Interrupt

Setup Interrupts

RB1
Lo?

Door Control
State Machine

What
caused Int

ISR

2
sec?
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Lab notesLab notes

Call a input checking routine from your main loop
Might need a state machine to track the different phases 
(open, close, etc.) and coordinate with your timing routines
Must loop back to look for next input

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Lab 6 (b) Lab 6 (b) 
Interrupt on INT PinInterrupt on INT Pin
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Feature Used:Feature Used:
Interrupt on INT PinInterrupt on INT Pin

PIC16F84APIC16F84A

RBPU
(1)

I/O
pin(2)

Data Latch
P

VDD

QD

CK

QD

Q D

EN

Data bus

WR Port

WR TRIS

RD TRIS

RD Port

Weak
pull-up

RD Port

RB0/INT

TTL
Input
Buffer

Schmitt Trigger
Buffer

TRIS Latch

Note 1: TRISB = '1’ enables weak pull-up
(if RBPU = '0' in the OPTION_REG register).

2: I/O pins have diode protection to VDD and VSS. 

CK

© 1999 Microchip Technology Incorporated. All Rights Reserved.

INT Pin SchematicINT Pin Schematic
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Lab6 (b) of 2 step labLab6 (b) of 2 step lab

Objective
Read input by interrupt on INT pin (optical sensor) to 
activate door opening/closing module you developed earlier
Light sensor on port pin RB0
RB0 is active low sensor input 
Validate using MPLAB simulator, your workshop board, and 
scale model prototype when finished
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Code Ex6b Code Ex6b -- INT Pin InputINT Pin Input

Set Prescaler

Reset TMR0

Sleep or
Wait for
Interrupt

Setup Interrupts

Int on INT pin

Door Control
State Machine

What
caused Int

ISR

2
sec?

TM
R

0
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Lab notesLab notes

Use different setup routines for the different interrupt modes
Might need a state machine to track the different phases 
(open, close, etc.) and coordinate with your timing routines
Don’t forget to put part to sleep or in a dead loop while 
waiting for interrupt on INT pin input (don’t overrun into 
unwanted areas)
Must loop back to look for next input

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Lab7 Lab7 
State Logic/Higher Order FunctionsState Logic/Higher Order Functions

PIC16F84APIC16F84A
1414--bit Corebit Core
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RBPU(1)

Data Latch
P

VDD

QD

CK

QD

CK

Q D

EN

Q D

EN

Data bus

WR Port

WR TRIS

Set RBIF

TRIS Latch

RD TRIS

RD Port

From other
RB7:RB4 pins

weak
pull-up

RD Port

Latch

TTL
Input
Buffer

I/O

Feature Used: Feature Used: 
Interrupt On Change Interrupt On Change 

PIC16F84APIC16F84A

Note 1: TRISB = '1’ enables weak pull-up
(if RBPU = '0' in the OPTION_REG register).

2: I/O pins have diode protection to VDD and VSS.
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Peripheral UsedPeripheral Used
PortBPortB Interrupt on Change exampleInterrupt on Change example

Internal pull-ups
(software option) keep
RB4-RB7 pins high

RB0-RB3 pins drive '0's

Any key pressed pulls
down an RB pin and
generates an interrupt

This interrupt wakes up
processor from SLEEP

Saves timer resources

Keypad interface:

PIC16CXXX

RB0
RB1

RB3

RB4
RB5

RB6
RB7

RB2

Hex keypad

R R ††

† Resistance for ESD protection

100 100 ΩΩ

AN557
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Interrupt On Change SchematicInterrupt On Change Schematic
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Lab7 State logic/higher order functionsLab7 State logic/higher order functions

Objective
Delay to hold door open approx 2 seconds before auto 
closing
Use “interrupt on INT pin” input method from Lab6(b) to 
start door sequence
Option 1
– Motor cutoffs 

– Position feed back
– Use interrupt on change 
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Lab7 State logic/higher order functionsLab7 State logic/higher order functions

Objective (cont.)
Option 2
– Do not close doors if INT pin sensor still active
– Safety feature
– People still in the doorway 

Option 3
– Independent motor cutoff 
– Different motor speeds

Validate using MPLAB simulator, your workshop board, and 
scale model prototype when finished
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Lab notesLab notes

Might need a state machine to track the different phases 
(open, hold open, close, etc.) and coordinate with your 
timing routines
Use different setup routines for the different interrupt modes
If adding motor cutoffs (option1), don’t use timing delay 
module while motors running (open or close). But use 
timing delay to hold door open for 2 sec.
Safety check (option2) only applies when closing doors
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Lab8 Proof Final FunctionalityLab8 Proof Final Functionality
PIC16F84APIC16F84A
1414--bit Corebit Core

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Lab8 combine labs 6 & 7 Lab8 combine labs 6 & 7 

Objective
Demonstrate final functionality of automatic door controller 
on workshop prototype board
– Combine all of the developed modules
– Demonstrate optional features if developed (I.e. emergency 

cutoffs, access light, double tap logic)
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MCUMCU
Robust DesignRobust Design

TechniquesTechniques

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Robust Design Techniques Robust Design Techniques 
Watchdog HardwareWatchdog Hardware

Helps recover from software malfunction
Uses its own free-running on-chip RC oscillator
WDT cannot be disabled by software
WDT overflow resets the chip
CLRWDT instruction clears WDT
Programmable time-out period: 18 ms to 2.5 seconds
Operates in SLEEP
On time-out wakes up CPU

8-bit ripple counter

"CLRWDT""CLRWDT"

ResetReset OverflowOverflow
resetsresets
chipchip

PostscalerRC
oscillator
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Robust Design Techniques Robust Design Techniques 
Watchdog Software StrategiesWatchdog Software Strategies

Watchdog effectivness is only as good as the             
software controlling it
Use one CLRWDT instruction for the entire program
Place CLRWDT in the main loop
Do not place CLRWDT in ISR or any sub-routines
Select the minimum WDT timeout period that main 
loop timing can tolerate
Initialize unused memory as GOTO wdtreset

(self-loop) to force timeout

© 1999 Microchip Technology Incorporated. All Rights Reserved.

Robust Design Techniques Robust Design Techniques 
Robust Software Robust Software -- Filling Unused MemoryFilling Unused Memory

When using watchdogs, fill unused memory 
locations with a GOTO wdtreset
This self loop is normally never executed
If the PC is corrupted, it is likely it will execute this 
instruction

Force a WDT reset to re-initialize the core
FILL can be used to insert these instructions 
(Substitute <last location+1> for 400h):

FILL (GOTO wdtreset), (400h-$)
ORG 3FFh
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Robust Design Techniques Robust Design Techniques 
Robust Software Robust Software -- Clean WDT resetClean WDT reset

To force WDT reset on power-up:
Check for RAM pattern at power-up
If pattern is not there:

Initialize RAM pattern
Force WDT reset 

Force WDT reset if code jumps to unused program 
memory
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Robust Design Techniques Robust Design Techniques 
Robust Software Robust Software -- Subroutine CountingSubroutine Counting

Maintain subroutine call and execution counters
Increment call counter for every subroutine call
Increment execution counter at the top of every sub-
routine
At the top of main loop, check if call and execution 
counters are equal
If not equal, force a WDT reset

Code Example: ADVRELSW.ASM
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The EndThe End
Thanks for attending!Thanks for attending!
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AppendixAppendix
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GlossaryGlossary

TMR0 - 8-bit timer peripheral w/8 bit 
prescaler
Prescaler - peripheral which delays the 
TMR0 count by a prescale ratio i.e. 1:1, 
1:2, 1:4
Page - memory organization for 
program memory
Bank - memory organization for data 
memory
Pipeline - hardware architecture for 
prefetching an opcode while executing 
the previous opcode
Orthogonal instruction set - instructions 
work on ports and registers the same 
way

OPTION_REG - register of control bits 
for configuring tmr0, INT, and pull ups
INTCON - register of control bits for 
configuring peripheral interrupts
STATUS - register of bits indicating the 
results of an operation
RP1&RP0 - direct addressing bank 
selection control bits
IRP - indirect addressing bank selection 
control bit
PORTB - I/O port B
GPIO - I/O port on the 8 pin parts

© 1999 Microchip Technology Incorporated. All Rights Reserved.

The Microchip name, logo, The Embedded Control Solutions Company, PIC, PIC, PICSTART, PICMASTER, PRO MATE, SEEVAL, KEELOQ and the 
KEELOQ logo are registered trademarks and MPLAB, fuzzyLAB, In-Circuit Serial Programming, ICSP, are trademarks of Microchip Technology Incorporated 

in the USA and other countries.
Windows is a registered trademark of Microsoft Corporation.

SPI is a trademark of Motorola.
I2C is a registered trademark of Philips Corporation.

Microwire is a registered trademark of National Semiconductor Corporation.
fuzzyTECH is a registered trademark of Inform Software Corporation.

All other trademarks herein are the property of their respective companies.

© 1999 Microchip Technology Incorporated. All rights reserved.
“Information contained in this publication regarding device applications and the like is intended through suggestion only and may be superseded by updates. 

No representation or warranty is given and no liability is assumed by Microchip Technology Inc. with respect to the accuracy of such information, or 
infringement of patents arising from any such use of otherwise. Use of Microchip’s products as critical components in life support systems is not authorized 

except with express written approval by Microchip. No licenses are conveyed, implicitly or otherwise, under any intellectual property rights.”


